
LESSON ONE // PAGE 1

NAVIGATING YOUR BOOK
Watch each tutorial and answer the questions. Then switch to eDesign and do the Guided Practice.

VIDEO TUTORIAL — NAVIGATING THE LADDER
1.	 The visual representation of all the book’s pages is called the 				    .

2.	 Name two of the pieces of information that you may see to the outside of a page’s thumbnail 
preview in the yearbook’s ladder view. � .

3.	 What does the “Jump to” function do in the ladder? � 	
�

4.	 What does the star icon in the ladder indicate? �

5.	 What does the View > Show Only My Pages command do? �  
�

GUIDED PRACTICE
�� Navigate to the Book module of eDesign and practice navigating the ladder. 
�� Scroll up and down, and use the “Jump to” function. 
�� Choose to “Show only My Pages” (this will only work if you are assigned to pages).

VIDEO TUTORIAL — USING THE PRACTICE SPREAD
1.	 What are two ways you can use the Practice Spread in eDesign? �  

�  
�

2.	 If you create something on your Practice Spread that you would like to keep, how can you save it to 
be used on your actual yearbook pages? �  
�

GUIDED PRACTICE
�� Open your Practice Spread and experiment with some of the eDesign tools.

VIDEO TUTORIAL — OPEN, SAVE AND CLOSE PAGES
1.	 If you do not see the Edit link beside a page in the ladder, what does this mean? �  

�

2.	 In Page Design, what do the Next and Previous buttons do? �  
�

3.	 How can you access a mini-ladder inside of Page Design? �

4.	 What are the two ways you can close a page and return to the full ladder view? �  
�

http://vimeo.com/40657883
http://vimeo.com/40658303
http://vimeo.com/40663258
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GUIDED PRACTICE
�� Open a page in Edit mode (if you are assigned to any pages) or View mode. 
�� Then use the Next and Previous buttons to move up and down in the ladder. 
�� Use the “All Pages” function to navigate to another spread.

VIDEO TUTORIAL — WHY AND WHEN PAGES ARE LOCKED
1.	 How many users can edit a page at a time? �

2.	 What does the padlock icon on a page mean? �

3.	 What does clicking the View link show you? �

4.	 What should you always do before closing your browser? �  
�

GUIDED PRACTICE
�� If other staff members are working in eDesign, look in the ladder for a padlock icon. Hov-

er over the padlock to see the identity of the staff member working on the page.
�� Open a spread in Page Design. Practice the two ways you can close a spread properly 

(File > Close Window and clicking the “Return to Book View” button).

http://vimeo.com/40664408
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USING THE IMAGE LIBRARY
Watch each tutorial and answer the questions. Then switch to eDesign and do the Guided Practice.

VIDEO TUTORIAL — UPLOADING IMAGES
1.	 What is the preferred type of image file for eDesign? �

2.	 How many images can you upload to eDesign in one batch? 			 

3.	 How can you hide the Import Images window while images are uploading? �  
	 �  
�

GUIDED PRACTICE
�� Upload a group of images to eDesign. 
�� Practice minimizing the Import Images window and navigating to another part of eDe-

sign while the upload is in progress. 

VIDEO TUTORIAL — TAGGING IMAGES
1.	 What are the three types of tags in eDesign? �

2.	 Who creates the list of Topic tags? �

3.	 Keywords are best used for what kind of information? �  
�

4.	 When an upload is complete, what button appears at the bottom of the Import Images window?  
�

GUIDED PRACTICE
�� Locate a few images in the Library and add some tags—Topics and/or Keywords.
�� Upload a new group of photos. When the upload is complete, choose “Tag Photos” and 

apply a Topic tag, Name tag or Keyword to the images.

VIDEO TUTORIAL — ROTATING, DELETING AND DOWNLOADING IMAGES
1.	 How do you open an image in the Preview window? �  

�

2.	 Name two other pieces of information you can see in the Data View of the Images Library? �  
�

3.	 When is it NOT possible to for you to rotate an image in the Image Library? �  
�  

4.	 True or False? You are only able to delete images you uploaded. �

http://vimeo.com/40665831
http://vimeo.com/40674629
http://vimeo.com/40676880
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5.	 How do you download an image to your local computer? �  
�

GUIDED PRACTICE
�� Go to the Images Section of the eDesign Library and open some images in Preview.
�� Practice rotating images clockwise and counter clockwise.
�� Delete an image you uploaded and then undelete it.

VIDEO TUTORIAL — SEARCHING AND FILTERING IMAGES
1.	 How do you clear a search in the Images Library? �

2.	 Where do you find the option to show only images that are Unused? �  
�

3.	 True or False? The same image search features are available within Page Design.  �

GUIDED PRACTICE
�� Practice searching images by Topics and Names. You should have tagged some images 

with Topics in the exercises for the previous tutorial, so you can filter by those Topics.
�� Use the “Filter by” control to show “Used Images,” “Unused Images” and “My Images.”

http://vimeo.com/40677719
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WORKING IN PAGE DESIGN
Watch each tutorial and answer the questions. Then switch to eDesign and do the Guided Practice.

VIDEO TUTORIAL — TOUR OF THE WORKSPACE
1.	 What is the keyboard shortcut for the Text tool? �

2.	 Under which menu is the Undo command located? �

3.	 Where is the Library panel located? �

4.	 How do you open the Library panel? �

5.	 Where is the Control panel located? �

GUIDED PRACTICE
�� Open a page in Page Design (you can use your Practice Spread). 
�� Switch tools by selecting them in the Tool panel and by using the keyboard shortcuts. 

Notice how the Control panel changes as you switch tools.
�� Open the different sections of the Library panel. Close the Library panel.

VIDEO TUTORIAL — UNDERSTANDING THE DESIGN AREA
1.	 The 		   is where the two pages come together in the center of the book. It divides the 

left page from the right page. 

2.	 Name something that should not be placed in the gutter? �

3.	 The 		   line is the thick red line surrounding the whole spread. 

4.	 If you want an object to bleed off the page, what should you do? �  
�

5.	 What is the area outside of the Bleed Line called? �

6.	 Where is the Folio located by default? �

GUIDED PRACTICE
�� Open a page in Page Design. Identify the gutter and the bleed line.

VIDEO TUTORIAL — COLUMNS, GRIDS AND GUIDES
1.	 When designing pages from scratch, 				     can be used to help you 

organize the content on your pages. 

2.	 How can you change the number of columns on a page? �  
�

http://vimeo.com/40680341
http://vimeo.com/40720426
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3.	 How can the Document Grid be helpful? �  
�

4.	 A Guide can be added to the page by dragging it out from the � .    

GUIDED PRACTICE
�� Open a spread in Page Design. Adjust the number of columns on the spread.
�� Turn the Document Grid on and off.
�� Create a horizontal and a vertical ruler guide.

VIDEO TUTORIAL — ZOOMING AND NAVIGATING
5.	 What does the Zoom tool look like? �

6.	 What happens if you hold down the Shift key and click with the Zoom tool? �

7.	 What are the two ways you can access the Fit to Window command? �  
�

8.	 What is the keyboard shortcut to zoom in on an object? �

9.	 What does the Hand tool allow you to do? �

GUIDED PRACTICE
�� Use the Zoom tool to zoom in and out on a page or spread. Use both the click and Shift-

click method to zoom, as well as the click and drag method.
�� Use the Zoom menu in the Tool panel to zoom in on a spread at a higher zoom percent-

age; then use the Fit to Window button to zoom back out.
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WORKING WITH OBJECTS
Watch each tutorial and answer the questions. Then switch to eDesign and do the Guided Practice.

VIDEO TUTORIAL — USING THE SHAPE TOOLS
1.	 What are the four shape tools? �

2.	 How do you draw a perfect circle with the Ellipse tool? �  
�

3.	 How do you open the Polygon options dialog box? �

GUIDED PRACTICE
�� Go to your Practice Spread and experiment with the shape tools. 
�� Draw a circle, a rectangle, a star and a polygon. 
�� Try creating different star or polygon shapes using the settings. 
�� Keep these shapes on the page. You will use them for the practice in the next tutorial.

VIDEO TUTORIAL — STROKE, FILL AND CORNER TYPE
1.	 The stroke is the 			    around a shape. 

2.	 If you set the stroke weight to 	 , the stroke will have no visible border. 

3.	 What is the Fill color? �

4.	 How can you select multiple shapes at the same time? �

GUIDED PRACTICE
�� Select a shape and practice changing the stroke color, the stroke size and the fill color. 
�� Select a rectangle and apply a 2-point black stroke. 
�� Practice applying different corner settings to the rectangle.

VIDEO TUTORIAL — ARRANGING OBJECTS
1.	 Under what menu are the arrange commands (such as Bring to Front) located? �

2.	 Which command moves an object behind everything else on the spread? �

GUIDED PRACTICE
�� Draw several shapes on a spread using the shape tools.
�� Fill the shapes with different colors. 
�� Then overlap the objects and practice using the arrange commands (Bring Forward, 

Send Backward, Bring to Front, Send to Back).

http://vimeo.com/40725247
http://vimeo.com/40725711
http://vimeo.com/40726168
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VIDEO TUTORIAL — ROTATING OBJECTS
1.	 What tool do you use to rotate an object? �

2.	 How can your remove rotation from an object? �  
�

GUIDED PRACTICE
�� Draw several shapes on the page and practice rotating them using the Selection tool. 
�� Also practice changing the rotation value in the Control panel.

VIDEO TUTORIAL — ALIGN AND DISTRIBUTE
1.	 With what type of objects can you use the Align and Distribute functions? �

2.	 To use the Align and Distribute functions, you have to 			    more than one object.

GUIDED PRACTICE
�� Draw several shapes on the page and practice using the Align and Distribute functions 

as shown in the tutorial.

http://vimeo.com/40726741
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WORKING WITH TEMPLATES
Watch each tutorial and answer the questions. Then switch to eDesign and do the Guided Practice.

VIDEO TUTORIAL — APPLYING TEMPLATES
1.	 Since most of the templates are 			   - 			   designs, you need to 

have both the left and right pages open for editing.  

2.	 Where do you access the templates in Page Design? �

3.	 How can you view a template in the Library at a larger size? �

4.	 What is the easiest way to remove a template immediately after you apply it to the spread? �  
�

GUIDED PRACTICE
�� Open a spread in Page Design. Go to the Templates section of the Library panel and 

review your template options (the templates that are currently active).
�� Apply a template to the spread. Select all the elements on the spread (Edit > Select All), 

delete them, and then apply another template.

VIDEO TUTORIAL — CREATING AND SAVING TEMPLATES
1.	 How do you save a design as a template? �

2.	 Why is it helpful to tag templates with Topics or Keywords? �  
�

GUIDED PRACTICE
�� Open a spread in Page Design. Create a custom design (from scratch or modify an exist-

ing template) and then save it as a template. NOTE: Use your Practice Spread if you are 
not assigned to an actual spread in the book.

�� Go to the Template section of the Library and tag the template with a Keyword.
�� Go back to a spread in eDesign (or your Practice Spread) and apply the new template.

VIDEO TUTORIAL — USING SMART TEMPLATE
1.	 If you want to use Smart Template, what should you choose when eDesign asks if you want to 

replace the existing content, Yes or No?  			 

2.	 How can you tell which images are not being used when you apply a new template? �  
�

3.	 What is the shortcut for using Smart Template? �
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GUIDED PRACTICE
�� Apply a template to a spread and add some photos. NOTE: Use your Practice Spread if 

you are not assigned to an actual spread in the book.
�� Drag and drop an new template on the spread and click Yes to replace the content.
�� Add some custom text (a headline for example) and then apply a new template. Use the 

Clipboard panel to drop the custom text onto the new design.

VIDEO TUTORIAL — WORKING WITH MODS
1.	 Where can you see printed samples of the GO! Design mods? �

2.	 What are the two categories of pre-designed mods? �

3.	 How do you save a custom mod? �  
�

4.	 True or False? You can use a mod on any layout you create? �

GUIDED PRACTICE
�� If your adviser or editor has activated mods, open an empty page and apply a mod.
�� Practice moving the mod to position it on the page. 
�� Then try editing some of the elements in the mod.
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WORKING WITH IMAGES
Watch each tutorial and answer the questions. Then switch to eDesign and do the Guided Practice.

VIDEO TUTORIAL — PLACING AND RESIZING IMAGES
1.	 When placing an image, what does the blue highlight line around an image frame mean? �  

�

2.	 After placing an image in a frame, what is scaled up or down when you click and drag on one of the 
square-shaped frame handles? �

3.	 Why does eDesign always keep the image in proportion when scaling it? �  
�

4.	 If you want to resize or reposition the image inside the frame, what button do you click? �  
�

5.	 When in the Picture Manipulation mode, what do the large circle-shaped handles allow you to size? 
 �

6.	 What is an alternate way to enter Picture Manipulation mode? �  
�

GUIDED PRACTICE
�� Draw shapes on a page in eDesign. Place a photo in each frame.
�� Practice resizing the image and the frame at the same time (notice how eDesign 

maintains the proportions).
�� Enter Picture Manipulation mode and resize/reposition the image inside the frame. Enter 

Picture Manipulation mode both by using the button in the Control panel and by dou-
ble-clicking on an image.

VIDEO TUTORIAL — PLACING AND CROPPING IMAGES
1.	 What function allows you to adjust the size and shape of a frame after you place an image inside?  

�

2.	 In Cropping mode, which handles control the frame? �

3.	 How do you replace an image in a frame? �  
�

GUIDED PRACTICE
�� Place an image inside a frame and zoom in on the frame. 
�� Enter the Cropping mode and practice resizing the frame and the image. 
�� Exit cropping mode.

http://vimeo.com/40733383
http://vimeo.com/40734883
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�� Drag an image on an empty area of the page. When asked if you want the image to be a 
Background, click the No button. 

�� Then, try it again, and click the Yes button. 
�� Then go to the Layout menu and choose Delete [Left or Right] Background Image.

VIDEO TUTORIAL — DPI WARNING AND RESOLUTION
1.	 Digital images are made up of small squares of color called what? �

2.	 What does the DPI warning look like? �

3.	 What should you do if you receive the DPI warning? �  
�

GUIDED PRACTICE
�� Place an image in a frame on a page. 
�� Scale the image up until you receive the DPI warning (Note: if you have very large imag-

es, you may not receive the DPI warning). Once the warning appears, scale the image 
back down until the warning disappears.

VIDEO TUTORIAL — DROP SHADOWS AND TRANSPARENCY
1.	 Where do you access the Drop Shadow option? �

2.	 Who can create a drop shadow style? �

3.	 Can you apply both Transparency and a Drop Shadow to an object? �

GUIDED PRACTICE
�� Place an image on a page in eDesign. Convert it to Black and White. Apply the Sepia 

effect. Set it back to Regular.
�� Place another image on the page. Apply a Drop Shadow to the image. Then apply 

Transparency. Place the transparent image partially on top of the other to see how they 
interact.

VIDEO TUTORIAL — SWAP IMAGES COMMAND
1.	 What key do you hold down to select more than one image on the page? �

2.	 In what menu is the Swap Images command located? �

3.	 What is the keyboard shortcut for the Swap Images command? �

GUIDED PRACTICE
�� Place two images on a page. Create a third empty frame on the page with one of the 

shape tools.
�� Use the Swap Images command to move the images among the frames. Try two frame 

at a time. Then try all three frames at the same time. Be sure to practice the keyboard 
shortcut method as well.

http://vimeo.com/40735744
http://vimeo.com/40739297
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WORKING WITH TEXT
Watch each tutorial and answer the questions. Then switch to eDesign and do the Guided Practice.

VIDEO TUTORIAL — ENTERING AND FORMATTING TEXT
1.	 What tool do you use to create a new text frame? �

2.	 What does a red underline beneath a word mean? �

3.	 What fonts appear in the fonts menu? �

4.	 The alignment options include the following: align left, align right, centered, and �

5.	 What happens when you double-click on a text frame with the Selection tool? �  
�

GUIDED PRACTICE
�� Draw a text frame on a page. Place your cursor inside the frame and type some text.
�� Select the text and experiment with the text formatting controls in the Control panel. 

Keep this text frame on the page for the Guided Practice in the next tutorial.

VIDEO TUTORIAL — NAME CHECK
1.	 When Name Check scans the text on pages for what does it search?�

�

2.	 How do you launch Name Check? �  
�  

GUIDED PRACTICE
�� If your adviser has imported a Master List of names into eDesign, you will be able to ex-

periment with Name Check. Go to a page and intentionally misspell your name. Launch 
Name Check. Search for your name and correct it.

VIDEO TUTORIAL — OVERSET TEXT
1.	 What does the red diamond on the lower right side of a text frame mean? �  

�

2.	 What are the three options for resolving overset text? �  
�  
�

3.	 How can you make the pop-up window appear to show you the text that is overset? �  
�

http://vimeo.com/40744626
http://vimeo.com/40744914
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GUIDED PRACTICE
�� Use the text frame you created in the Guided Practice for the previous tutorial. Make the 

text frame smaller until you have overset text and the red diamond appears in the lower 
right of the text frame.

�� Experiment with the different methods shown in the tutorial for fixing overset text.

VIDEO TUTORIAL — APPLYING CHARACTER STYLES
1.	 Character Styles in eDesign are preset � definitions. 

2.	 Who can create new Character Styles? �

3.	 Name three advantages to using Character Styles? �  
�

GUIDED PRACTICE
�� Go to a page in eDesign, create a new text frame and type in some text.
�� Select the text and experiment with applying Character Styles. Even if you do not have 

any custom styles, you can experiment with the default styles.

VIDEO TUTORIAL — TEXT FRAME PADDING
1.	 The Text Frame Padding control appears only when the�  is inside a text frame. 

2.	 How is the Text Frame Padding measured? �

GUIDED PRACTICE
�� Create a text frame. It will automatically fill with placeholder text.
�� Place your cursor inside a text frame and experiment with Text Frame Padding. You may 

want to apply a color fill the text frame to make the change more obvious.

VIDEO TUTORIAL — TEXT WRAP
1.	 Does Text Wrap work with any kind of shape? �

2.	 What does a positive value in Wrap Padding do? �  
�

3.	 True or False? Text will only wrap around shapes that are beneath the text frame. �

4.	 Text wrap only works on text that is aligned to the ______.      

GUIDED PRACTICE
�� Create a text frame and enter some text. Activate the Shape Wrap option for Text Wrap.
�� Draw a new shape with one of the shape tools. 
�� Overlap the shape with the text frame and experiment with the Text Wrap settings.
�� Practice arranging the object. Place the text frame on top of the shape to deactivate Text 

Wrap. Then, use Object > Bring to Front to place the object on top of the text frame, 
which will reactivate Text Wrap.

http://vimeo.com/40257171
http://vimeo.com/40745186
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VIDEO TUTORIAL — TEXT ON A PATH
1.	 Name one of the two ways to access the Text on a Path options. �  

�

2.	 What does a positive Distance value do to the text? �

3.	 What does the Flip option do to the text? �

GUIDED PRACTICE
�� Draw an elliptical shape on a page. Then select the shape and click the Text on a Path 

button in the Control panel.
�� Enter and format the text in the Text on a Path dialog box and experiment with the differ-

ent settings.
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ADDING GRAPHICS AND ART
Watch each tutorial and answer the questions. Then switch to eDesign and do the Guided Practice.

VIDEO TUTORIAL — DRAWING CUSTOM PATHS
1.	 What tool do you use to draw custom paths or shapes? �

2.	 How do you stop drawing an open path? �

3.	 How do you make the Pen tool draw straight lines and corner points? �  
�

4.	 What tool do you use to manipulate paths and shapes you have drawn? �

5.	 How do you add a point to a path? �

6.	 How do you remove a point from a path? �

GUIDED PRACTICE
�� Use the Pen tool to draw a curved open shape. 
�� Use the Pen tool to create a closed shape. 
�� Use the Pen tool to create a shape with straight lines and corner points.
�� Use the Edit Path tool to manipulate the points on the paths that you have created. 

VIDEO TUTORIAL — BACKGROUNDS AND ART
1.	 To locate the activated backgrounds in the Art Library, type �  in the Search function. 

2.	 What tool allows you to add color backgrounds to the page? �

3.	 How can you force one image background to replace another image background (without removing 
the first one)? �

4.	 True or False? The steps for placing clip art on the page is the same as placing images. �

GUIDED PRACTICE
�� Apply a background graphic or image as a background. Remove and apply another. 
�� Then apply a color background. Then change the color to an image background.
�� Use the Shift command to place a background graphic or replace an existing graphic.
�� Place a piece of clip art from the Art Library on the page.

VIDEO TUTORIAL — PHOTOS IN TEXT
1.	 What kind of fonts will work best when putting photos in text? �

2.	 What command do you use to change the text to an image frame? �

3.	 True or False? Once converted to a shapes, text can still be edited. �

4.	 What is the maximum point size for text? �

http://vimeo.com/40458466
http://vimeo.com/41008269
http://vimeo.com/40477914
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GUIDED PRACTICE
�� Create a new text frame, and keystroke in a word in all caps. Set the text in a thick font, 

and a large point size.
�� Convert the text into shapes and place an image inside the text shapes.

VIDEO TUTORIAL — CREATING COMPOUND SHAPES
1.	 How many shapes must be selected before “Compound Shapes” can be used? �

2.	 Under which menu is the “Compound Shapes” command located? �

3.	 You can compound any closed shapes created with the shape tools or the�  tool. 

GUIDED PRACTICE
�� Draw shapes using one of the tools. Select them all and create a compound shape.
�� Place an image in the closed shape and use the Picture Manipulation mode to adjust the 

image inside the Compound shape.

http://vimeo.com/40595720

